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1     

1.1  

ATMEL사의 8 비트 프로세서인 AVR-ATmega128MCU 를 이용하여 각종 디바이스학습 및 제어 시 유용하게 

사용되는 AVR 트레이닝 보드이다. 초보자를 세심하게 배려 하기 위하여 모든 부품의 부품이름 및 부품정보가 

트레이닝보드에 기록 되어 있으며, 확장성을 고려하여 입출력포트를 1x8 헤더소켓 커넥터로 설계하여 외부 

확장보드 및 모듈 연결을 간편하게 이용할 수 있도록 구성하였다. 또한 전원공급상태를 확인 할 수 있는 

전원 LED 및 AVR ISP 와 AVR JTAG ICE 을 지원하여 프로그램 다운로드 및 디버깅 가능하도록 설계 되었다. 

 

<그림 1-1-1> LKino MEGA 128 트레이닝 보드 

1.2  

AVR-ATmega128 MCU 의 모듈 지원, 16Mhz 크리스탈  

LED 8EA, SW 8EA, BUZZER 를 이용한 입출력 제어 

1Digit 7-Segment 를 이용한 출력 제어 

시계(RTC DS1307)IC 를 이용한 I2C 통신 제어 

16*2Line텍스트형 LCD 모듈을 이용한 LCD 문자 출력 제어 

RS232 통신을 이용한 시리얼 통신 제어  
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조도센서(CDS), 온도센서(NTC)를 이용한 ADC 제어 

입출력포트 확장을 고려한 아두이노형(헤더소켓)커넥터 내장 

AVR ISP, AVR JTAG ICE 개발장비를 이용한 프로그램 다운로드 및 디버깅 가능 

 

<그림 1-2-1> LKino MEGA 128 트레이닝 보드 구성 
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1.3   

1.3.1 2x16    

 

<그림 1-3-1> 2x16 헤더소켓 핀 배치 

1.3.2      

 

<그림 1-3-2> 입출력 확장 포트 핀 배치 
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1.3.3      

 

<그림 1-3-3> 전원 확장 포트 핀 배치 

 

1.3.4 AVR ISP & AVR JATG ICE     

 

<그림 1-3-4> 10P 핀 헤더 핀 배치 

 

1 3 5 7 9 

TCK TDO TMS 5V TDI 

2 4 6 8 10 

MOSI MISO SCK RESET GND 

<표 1-3-1> 당사 AVR ISP 및 AVR JTAG ICE 10P 핀 헤더 핀 배치 
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1 3 5 7 9 

MOSI x RESET SCK MISO 

2 4 6 8 10 

5V GND GND GND GND 

<표 1-3-2> Atmel AVR ISP 10P 핀 헤더 핀 배치 

참고  

LK-USB AVR ISP 또는 LK-USB AVR JTAG ICE 개발장비를 이용하여 ATmega128 MCU 는 프로그램 다운로드 및 

디버깅이 가능하다. 

1.4    

1.4.1   

본 트레이닝 보드는 DC 5V 전원으로 구동된다. 우리들이 일상생활에서 흔히 접할 수 있는 볼트의 단위는 

110V, 220V의 상용AC 전원과 배터리에서 사용되는 1.5V, 3V, 9V 등의 DC 전압 단위가 있다. 

LKino MEGA128 트레이닝 보드에서 사용되는 DC 5V 전압은 디지털 전자기기에서 대표적으로 사용하는 

전압단위로서, 일반인들이 흔히 접하는 전압은 아니다. 하지만 전자회로에서는 거의 DC 5V가 사용되고 

있다고 볼 수 있을 정도로 자주 등장하는 전압이다. 

일반적인 사용전압에서 DC 5V 를 만들어 내는 방법은 여러 가지가 있다. 이중에서 가장 일반적으로 사용하는 

DC 5V 발생회로를 소개 하겠다. 

 

<그림 1-4-1> 전원 회로도 

이 회로에서 가장 핵심적인 역할을 담당하는 부품은 7805 라는 전원 안정화(3 단자 전원 레귤레이터)소자이다. 

7805 의 입력 단에 DC 9V ~ DC 12V 사이의 전원을 인가하면 출력 단에는 DC 5V 전압이 출력된다. 7805 는 

3 단자로 되어 있으며, 가운데 단자는 GND 와 접속하면 된다. 
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입력 단 및 출력 단에 붙인 콘덴서는 발진을 방지하는 역할을 수행한다. DC 12V이상의 전압공급 및 

사용전류가 많아지면 7805 에서 열이 발생하므로 사용 시 주의해야 한다. 

1.4.2 LED, S/W, BUZZER  

 

<그림 1-4-2> LED, S/W 회로 

<그림 1-4-2>에서 LKino MEGA128 트레이닝 보드는 기본 LED 및 TACT S/W 가 구성 되어 있다. 

LED 구동 시 해당 핀에HIGH(DC 5V)를 출력하면 LED 가 점등되며 이때 330 옴 저항은 과전류를 방지하기 

위한 목적으로 설계 되었다. 또한 TACT S/W 입력 시 입력레지스터에 논리 상태가 HIGH(DC 5V) ->LOW(0V)로 

변하여 TACT S/W 입력 상태를 확인 할 수 있으며 이때 0.1uF 세라믹 콘덴서는 TACT S/W 입력 시 발생하는 

채터링을 방지하기 위한 회로이고, 4.7KΩ 풀 업(Pull up)저항은 평상 시 상태를 HIGH(DC 5V)로 만들어 주기 

위하여 설계 되었다.  
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DC 5V 이상의 전압입력 시 “삐~” 소리가 나는 대표적인 신호용 부저인 능동 부저(PASSIVE BUZZER)는 해당 

핀에 LOW(0V)를 출력하면 청각을 통해 부저음을 사용자에게 전달한다.  

1.4.3 RS232   

 

<그림 1-4-3> RS232통신 회로 

 

<그림 1-4-3>에서 RS232 통신의 신호 전압레벨은 DC ±12V이다. 높은 전압으로 구동하는 이유는 외부에서 

들어오는 노이즈로부터 오동작을 방지하기 위한 조치이며 RS232 통신을 사용하기 위해서는 장비 상호간의 

통신 전압레벨을 맞춰줘야 한다. 주변기기들은 대부분 DC 0 ~ 5V 또는 DC 0 ~ 3.3V로만 동작하는데, 이런 

기기들과 PC와 RS232 통신을 하고자 할 때 신호 전압레벨 맞추기 위해서 MAX232 IC 를 사용한다. 

MAX232 IC 는 DC 5V 를 받아 내부적으로<그림 1-4-3>에서 C1+, C1-, C2+, C2- 핀에 접속 된 콘덴서에 의해. 

승압을 하여 DC 10V를 만들어 출력한다. 회로에서 왼쪽 편 RS232_TXD, RS232_RXD는 DC ±12V로 들어오고 

나가는데 비해 오른쪽 RX, TX 는 DC 0~5V로 신호가 바뀐다. 즉 오른쪽의 R2IN에서 DC 0~5V 가 들어가면 

왼쪽 편 RS232_RX 단자로는 DC -12V ~ +12V(실제로는 DC -10V ~ +10V)로 신호 전압레벨이 출력 된다. 
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1.4.4 RTC(DS1307)   I2C   

 

<그림 1-4-4> RTC(DS1307) 시계 IC 회로 

<그림 1-4-4>에서 DC1307 은 RTC(Real Time Clock)이다. 전자 시계를 만들기 위해서 실시간 클럭을 사용할 

필요 없이 메인 클럭을 분주하여 1 초를 만들고 프로그램을 작성하여 시간을 만들어낼 수 있을 것이다. 

하지만, 전원이 차단되었을 때 카운팅 되고 있던 시간 정보는 사라져 버리게 된다. 

RTC 는 실시간 클럭을 외부에 32.768Khz 크리스탈과 DC 3V전압의 배터리를 달아 놓으면 MCU 나 외부의 

전원이 없이도 계속 시간을 카운팅 하여 시간을 유지할 수 있는 장점을 가지고 있는 IC이다.  

<그림 1-4-4>에서 R7, R8 에 4.7K 옴은 I2C통신을 하기 위한 풀 업(Pull up)저항이며, SCL(시리얼클럭)과 

SDA(시리얼데이터)는 MCU 에 연결한다. 

Y1 32.768Khz 수정 진동자(크리스탈)의 발진회로는 원래 수정 진동자(크리스탈)의 양단에 22pF 에 커패시터 

접속하여야 하는데, DS1307 내부에 커패시터가 내장되어 수정 진동자(크리스탈) 32.768Khz 만 극성 없이 

접속하면 된다. 

DS1307 특징 

시, 분, 초, 월, 요일을 카운팅 하며, 또 이러한 정보를 I2C 통신을 이용하여 설정 및 읽기가 가능하다. 

월 마지막 날짜를 자동으로 제어한다. 

24 시 모드, AM/PM 모드가 있다. 

데이터를 저장할 56Byte 비휘발성 RAM 을 가지고 있다. 

2 개의 선을 가지는 직렬 인터페이스(I2C 통신 포트 지원) 

자동으로 전력차단을 감지하고 배터리 모드로 회로를 스위칭 할 수 있다. 

오실레이터와 배터리를 백업모드로 사용시 500nA 이하로 전력을 소비한다. 

작동온도 -40 도~85 도까지 사용 가능하다. 
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1.4.5 FND(7-Segment LED)  

 

<그림 1-4-5> FND(7-Segment LED) 회로 

<그림 1-4-5>에서 FND(7-Segment LED)(Common Cathode) 구동 회로도이며, 해당 핀에 데이터를 입력하고, 

공통 핀에 LOW(0V)신호(Digit 신호)를 입력하여 FND(7-Segment LED)를 구동 한다. 

FND 

FND는 “Flexible Numeric Display” 약자 이며 유동적인 숫자 및 영자 표시기로서, LED(발광 다이오드) 7 개를 

사용하여 0, 1, 2, 3, 4, 5, 6, 7, 8, 9, a, b, c, d, e, f 를 표시할 수 있는 부품이다. 숫자로 표현하거나 영어로 표시 할 

때 사용하며, 실생활에서는 엘리베이터 및 시계 문자 디스플레이 용도로 많이 사용한다.  

다이내믹 디스플레이 방식 

FND(7-Segment LED)가 여러 개인 경우 다이내믹 디스플레이방식을 이용하여 데이터를 표시해야 한다. 

마이크로 컨트롤러(MCU)에 의해서 출력되는 펄스를 일정 시간 간격(30ms~40ms)으로 각 FND의 디지트(Dig1, 

Dig2, Dig3, Dig4) 및 데이터(a, b, c, d, e, f, g, dp 구동펄스)를 출력 하면, 잔상효과를 이용하여 마치 여러 개가 

동시에 켜진 것처럼 표시하는 방법이다. 이 경우 FND 출력의 시간, 간격에 따라 표시 밝기가 변하고 

깜박거림이 발생할 수 있으므로, 마이크로 컨트롤러에서는 타이머 카운터 인터럽트를 이용하여 정확한 시간 

간격마다 각 디지트 및 해당하는 데이터를 출력하고 ON 시간을 유지하는 정밀한 타이밍 제어가 요구 된다. 
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1.4.6 (ADC0), (ADC1), (ADC2)  

 

<그림 1-4-6> 조도, 온도, 포토센서 

온도센서 

열에 민감한 저항체라는 의미로 온도 변화에 따라 저항 값이 극단적으로 크게 변하는 감온 반도체이다. 

특징은 소형으로 빠른 응답속도를 갖고 사용 온도 범위가 -50~500℃로 일상적인 온도 조절을 필요로 하는 

모든 범위에 응용된다. 보드 내에 PORTF2 번 핀으로 아날로그 전압(DC 0~5V)이 입력된다.  

 

<그림 1-4-7> 써미스터(Thermistor) 

조도센서 

광 센서의 가장 기본적인 센서로서, 빛의 밝기에 대하여 전기적인 성질로 변환시켜주는 역할을 하는 센서이다. 

“광도전셀” 이라고도 불리기도 하며, 밝기에 비례하여 저항이 선형적으로 증가하는 것이 아니라 로그 

그래프에 가까운 형태를 그리기 때문에 정확한 Lux 값을 구하기 보다는“아주 밝다/ 밝다/ 어둡다” 정도만을 

판별하기에 적합한 센서이다. 보드 내에 PORTF2 번 핀으로 아날로그 전압(DC 0~5V)이 입력된다. 

 

<그림 1-4-8> CDS10K 
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1.4.7  LCD    

 

<그림 1-4-9> 텍스트형 LCD 모듈 

텍스트형 LCD 모듈 

영어, 알파벳, 글꼴 데이터를 저장하고 있는 ROM을 가지고 있어서 ASCII 코드만으로 문자를 출력할 수 

있도록 만들 모듈이다.  

텍스트형 LCD모듈은 문자를 표시하기 위한 것이라 픽셀 수가 적기 때문에 그래픽 데이터를 출력하기에는 

적당하지 않다.  

5*7 픽셀을 사용하여 한 문자를 표현하며 한 줄에 16 문자까지 출력할 수 있는 LCD 패널이 많이 사용되고 

있으며, LCD패널은 사용자 입력에 따라 각 픽셀을 ON/OFF 제어가 가능하다.  

거의 대부분의 LCD 모듈은 Hitachi 사의 HD44780 이나 이와 호환이 되는 제어기를 사용하고 있다.  

한글 문자 표현은 불가능하다.  

LCD 에 정보를 출력하는 과정은 LCD 제어 명령 전송과 데이터 전송의 두 부분으로 이루어져 있다. 

마이크로 컨트롤러는 글자를 출력할 위치, 방향, 깜빡임 여부 등 여러 설정을 위한 명령을 LCD 제어모듈에 

전송하여 필요한 설정을 한 다음 출력하고자 하는 글자의 ASCII 코드를 LCD 제어 모듈에 전송한다. 
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신호 동작 

RS(PA0) 
Register selection 

1: Data register 0: Instruction register 

R/W(PA1) 
Read/Write selection 

1: Read 0:Write 

E(PA2) 
Enable signal 

E 의 하강 Edge에서 데이터를 전달 

<표 1-4-1> 텍스트형 LCD모듈의 컨트롤 신호 

 

<그림 1-4-10> 텍스트형(문자)형 LCD 모듈의 제어 명령표 



TITLE:  Education 

LKino-MEGA128TB Manual 

LK Development Team 

Status 

Revision V0.1 

 

Date 2017/01/05 

Doc LK임베디드 

S/N   

 

2017 LK EMBEDDED                 LKino-MEGA128TB Manual version 1.0 제1장 제품설명 및 특징 페이지 16 

 

<그림 1-4-11> 텍스트형 LCD모듈의 동작 타이밍 
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텍스트형 LCD모듈4비트 인터페이스의 경우 초기화 프로그래밍 순서 

CPU 와 텍스트형 LCD모듈 모듈 사이에 4 비트 데이터 버스를 사용하여 인터페이스 한 경우에 LCD모둘에 

전원을 투입하고 나서 이를 초기화 하여 사용하는 과정을 요약하면 다음과 같다. 

전원을 투입하거나 리셋 스위치를 누른다. 

초기화를 수행하기 전에 최소한 30ms 이상을 대기한다. 

Function Set 명령(0x28)을 상위 4 비트와 하위 4 비트로 나누어 각각 DB7~DB4 로 출력한다. 

Display ON/OFF control 명령(0x80)을 상위4 비트와 하위4 비트로 나누어 각각 DB7~DB4 로 출력한다. 

DD RAM 어드레스를 상위 4 비트와 하위 4 비트로 나누어 각각 DB7~DB4 로 출력한다. 

표시할 문자 데이터를 상위 4 비트와 하위 4 비트로 나누어 각각 DB7~DB4 로 출력한다. 

  



TITLE:  Education 

LKino-MEGA128TB Manual 

LK Development Team 

Status 

Revision V0.1 

 

Date 2017/01/05 

Doc LK임베디드 

S/N   

 

2017 LK EMBEDDED                 LKino-MEGA128TB Manual version 1.0 제1장 제품설명 및 특징 페이지 18 

1.5  
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1.6  Dimension 

 

<그림 1-6-1> LKino MEGA128 트레이닝보드 외형 치수(PCB Dimension) 
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2    

2.1 Atmel Studio 7.0  

AVR 마이크로 컨트롤러의 ISP 기능을 이용하여 PC에서 프로그램 코드를 작성한 후, 결과파일(*.Hex)을 

ATmega128 의 플래시 메모리에 다운로드 하여 구동할 수 있다. 코드 작성 및 프로그램 다운로드를 진행하기 

위해서는 LK 프로그램 다운로더(USBasp)를 연결한 후 Atmel Studio 7.0(통합 개발 환경 프로그램)를 이용하여 

프로그램을 손 쉽게 다운로드 할 수 있다. 

 

<그림 2-1-1> Atmel Studio 7.0 시작 화면 

2.1.1 Atmel Studio 7.0  

Atmel 홈페이지에 접속하여 Atmel Studio 7.0 인스톨 파일을 다운로드 받아 설치한다. Atmel Studio 7.0 은 

Atmel 소프트웨어 프레임워크 3.32.0 과 Atmel 툴체인을 포함하고 있어 별도의 추가 설치 과정이 필요 없다. 

Atmel Studio IDE 다운로드 페이지 

 

<그림 2-1-2> Atmel Studio IDE 다운로드 페이지 

  

http://www.atmel.com/tools/atmelstudio.aspx?tab=overview
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2.1.2 LK  (USBasp)   

LK 임베디드 홈페이지(www.lkembedded.co.kr) 자료실 또는 아래의 링크를 통해 LK 프로그램 다운로더(USBasp) 

드라이버를 다운로드 받아 압축을 풀고 설치한다. 드라이버 설치 후 LK 프로그램 다운로더(USBasp)를 PC 에 

연결하고 장치관리자를 통해 정상적으로 인식이 되었는지 확인한다. 

LK 프로그램 다운로더(USBasp) 드라이버 다운로드 

 

<그림 2-1-3> 장치관리자 

2.1.3 AVRDUDE  

AVRDUDE 는 AVR 마이크로 컨트롤러의 ISP(In System Programing) 기능을 이용해 ROM 과 EEPROM 이미지를 

업로드 하는 유틸리티이다. 아래 링크를 통해 다운로드 받는다. 

AVRDUDE 6.3 다운로드 

 

<그림 2-1-4> AVRDUDE 6.3 

http://www.lkembedded.co.kr/
http://www.lkembedded.co.kr/shop/board/download.php?id=referb&no=79&div=0
http://download.savannah.gnu.org/releases/avrdude/avrdude-6.3-mingw32.zip
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다운로드 받은 “avrdude.exe”와 “avrdude.conf” 2 개의 파일을 “C:\Program Files (x86)\Atmel\AVR Tools” 경로에 

“AVRDUDE” 폴더를 생성하여 이동시킨다. 

 

<그림 2-1-5> “C:\Program Files (x86)\Atmel\AVR Tools” 경로에 “AVRDUDE” 폴더를 생성 

 

<그림 2-1-6> “avrdude.exe”와 “avrdude.conf” 2개의 파일 이동 
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2.1.4 Atmel Studio 7.0  AVRDUDE  

Atmel Studio 7.0 을 실행시켜 상단 메뉴 바의 “Tools → External Tools”를 클릭한다. 

 

<그림 2-1-7> External Tools 클릭 

External Tools 창에서 아래의 정보를 입력 후 “Use Output window”옵션을 체크하고 “OK”버튼을 클릭한다. 

Title: USBasp 

Command: C:\Program Files (x86)\Atmel\AVR Tools\AVRDUDE\avrdude.exe 

Arguments: -p m128 -c usbasp -P usb -U flash:w:"$(ProjectDir)Debug\$(TargetName).hex":i 

 

<그림 2-1-8> External Tools 정보 입력 창 
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2.1.5 Atmel Studio 7.0   

상단 메뉴 바의 “File → New → Project”를 클릭하거나 “Ctrl+Shift+N”을 누른다. 

 

<그림 2-1-9> 프로젝트 생성 클릭 

프로젝트 생성 창이 열리면 “GCC C Executable Project”를 선택하고 “Name”란에 프로젝트명을 입력 및 “Create 

directory for solution” 옵션을 체크 해제 후 “OK”버튼을 클릭한다. 

 

<그림 2-1-10> 프로젝트 생성 창 
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디바이스 선택 창이 열리면 “ATmega128A”를 찾아 더블 클릭하거나 “OK”버튼을 클릭한다. 디바이스를 

선택하면 프로젝트 생성 진행 창이 열린 후 기본 틀의 코드가 생성된다. 

 

<그림 2-1-11> 디바이스 선택 창 

 

<그림 2-1-12> 프로젝트 생성 진행 창 

 

<그림 2-1-13> 프로젝트 기본 틀 코드 생성 
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2.1.6 Atmel Studio 7.0  LK  (USBasp)     

프로그램 코드를 작성한 후 상단 메뉴 바의 “Build → Build Solution”을 클릭하거나 “F7”을 누른다. 작성한 

코드에 문제가 없다면 하단의 결과 창에 아래 그림과 같은 메시지가 출력된다. 

 

<그림 2-1-14> 솔루션 빌드 

솔루션 빌드 후 상단 메뉴 바의 “Tools → USBasp”를 클릭한다. 프로그램 업로드가 정상적으로 되었다면 

하단의 결과 창에 아래 그림과 같은 메시지가 출력된다. 

 

<그림 2-1-15> 프로그램 업로드 
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2.2    

아두이노 스케치는 프로그램 코드를 작성하고 코드에 오류가 없는지 검사하고 오류가 없다면 업로드까지 

한번에 다 되는 아주 편리한 개발 툴이다. 

2.2.1     

다음의 아두이노 사이트에서 사용하는 운영 체제에 맞는 것으로 다운로드 한다. 

주소: https://www.arduino.cc/en/Main/Software  

 

<그림 2-2-1> 아두이노 스케치 다운로드 

본 매뉴얼에서는 윈도우를 기반으로 설명을 하겠다. 다운로드 후 설치 경로를 변경 안하고 설치를 하면 

C:\Program Files (x86)\Arduino 에 설치가 된다. 

 

<그림 2-2-2> 아두이노 스케치 폴더 

위 <그림 2-2-2>에서 빨간 박스 안에 있는 프로그램이 아두이노 스케치 실행파일이다. 

https://www.arduino.cc/en/Main/Software
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<그림 2-2-3> 아두이노 스케치 실행화면 

스케치를 실행하면 <그림 2-2-3>과 같은 화면이 나온다면 스케치는 정상적으로 설치가 완료되었다. 

2.2.2    MegaCore  

아두이노 스케치 실행 후 상단 메뉴 바의 “파일 → 환경설정”을 클릭한다. 

 

<그림 2-2-4> 아두이노 스케치 환경설정 클릭 
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아두이노 스케치 환경설정 창이 열리면 “추가적인 보드 매니저 URLs” 창 열기 버튼을 클릭한다. 

 

<그림 2-2-5> 아두이노 스케치 환경설정 창 

추가적인 보드 매니저 URLs 창이 열리면 “비공식 보드 지원 URL 목록을 보려면 클릭하세요”를 클릭한다. 

 

<그림 2-2-6> 추가적인 보드 매니저 URLs 창 

Arduino GitHub에 접속되며 스크롤을 아래로 이동하여 “MegaCore”의 URL을 복사한다. 

https://mcudude.github.io/MegaCore/package_MCUdude_MegaCore_index.json 

 

<그림 2-2-7> Arduino GitHub 

  

https://mcudude.github.io/MegaCore/package_MCUdude_MegaCore_index.json
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복사한 URL을 “추가적인 보드 매니저 URLs”에 붙여넣기 후 “확인” 버튼을 클릭한다. 

 

<그림 2-2-8> 아두이노 스케치 환경설정 창 

아두이노 스케치 환경설정 창이 닫히면 상단 메뉴 바의 “툴 → 보드: → 보드 매니저”를 클릭한다. 

 

<그림 2-2-9> 보드 매니저 클릭 
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보드 매니저 창이 열리면 스크롤을 아래로 이동하여 “MegaCore “ 선택 후 “설치”버튼을 클릭한다. 

 

<그림 2-2-10> 보드 매니저 창 

MegaCore 설치 후 상단 메뉴 바의 “툴 → 보드: → ATmega128”을 클릭한다. 

 

<그림 2-2-11> 보드 선택 
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2.2.3   LK  (USBasp)     

아두이노 스케치에서 프로그램 코드를 작성한 후 상단 메뉴 바의 “스케치 → 확인/컴파일”을 클릭하거나 

“Ctrl+R”을 누른다. 작성한 코드에 문제가 없다면 하단의 결과 창에 아래 그림과 같은 메시지가 출력된다. 

 

<그림 2-2-12> 프로그램 코드 컴파일 

프로그램 코드를 컴파일 한 후 상단 메뉴 바의 “툴 → 프로그래머: → USBasp”를 클릭한다. 

 

<그림 2-2-13> 프로그래머 선택 
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프로그래머를 선택한 후 상단 메뉴 바의 “스케치 → 프로그래머를 이용해 업로드”를 클릭하거나 

“Ctrl+Shift+U”를 누른다. 프로그램 업로드가 정상적으로 되었다면 하단의 결과 창에 아래 그림과 같은 

메시지가 출력된다. 

 

<그림 2-2-14> 프로그래머를 이용해 업로드 



TITLE:  Education 

LKino-MEGA128TB Manual 

LK Development Team 

Status 

Revision V0.1 

 

Date 2017/01/05 

Doc LK임베디드 

S/N   

 

2017 LK EMBEDDED                 LKino-MEGA128TB Manual version 1.0 제3장 Epilog 페이지 34 

3  Epilog 

3.1    

LK 임베디드 홈페이지문의: WWW.LKEMBEDDED.CO.KR 상담문의게시판 이용 

LK 임베디드 카페문의: http://cafe.naver.com/lkembedded 제품Q&A 게시판 이용  

엔지니어 이메일 기술문의: LKN9270@lkembedded.co.kr 

제품 구매 문의: Tel. 02-968-8617  

LK 임베디드 모든 제품에 DC 전원공급 시 반드시 극성(+, -)를 확인 하시여 전원을 공급해주시고, 제품 

정격전압을 꼭 지켜 주셔야 합니다. 만일 이를 어길 시에는 제품에 치명적인 오류 및 파손이 발생할 수 

있으니 각별한 주의가 필요합니다.  

3.2   

LK 임베디드 제품을 구입해 주셔서 감사합니다. 당사는AVR, PIC, ARM7(STM32F103)을 사용하시는 

고객님의 편의를 증진시키기 위해서, 마이컴 교육 및 신제품 연구개발을 위해서 항상 

노력하고 있습니다. 앞으로도 끊임없는 도전정신을 바탕으로 신제품개발, 완벽한 

품질보증 체계확립, 대 고객 서비스를 통해 고객의 마음을 편하게 하는데 정진할 것입니다. 

본 제품을 활용하여 마이컴 학습 및 제품개발에 큰 도움 되시기를 바랍니다. 

http://www.lkembedded.co.kr/
http://cafe.naver.com/lkembedded
mailto:LKN9270@lkembedded.co.kr

